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Membership
Adding Family Address Records 

NOTE 2.1: If most of the families to be recorded in CDM Plus for your church live 
in the same town with the same zip code, CDM Plus can automatically load that 
information for you. Choose Preferences/Settings under Setup on the File menu and 
select Membership. Fill in the County, City, State, Zip, and Default Mailing Code 
which will most often be used. Click Save. Now when a Family Address Record is 
added, this City, State, Zip, and Mailing Code will automatically load in those fields. 
For those not living there, the fields can be changed during data entry. 

NOTE 2.2: You may also want to create a standardized phone display at this time. For 
information on doing so (also called creating a Phone Mask), see item 17 below. 

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.. 

2- Under Membership select Family 
Address Records or click the Family 

Address Records icon  on the 
menu bar. 

3- Click the Add button. The cursor 
will appear automatically in the 
Last Name field. Type the family 
last name. Title Case is suggested 
(e.g. - Smith). Do not use only 
UPPERCASE. Labels can be gener-
ated in UPPERCASE when neces-
sary since the Post Office prefers 
UPPERCASE.

4- Tab through the Suffix, Mailing Name and Salutation fields, entering information into each field as 
described in steps 5, 6 and 7 below.

5- If applicable, type a suffix (e.g., Jr., Sr. or III) in the suffix field. Leave this field blank if there is no suffix.

6- Type the family mailing name (e.g., Mr. & Mrs. William or Mr. and Mrs. William). Do not type the last 
name again here. Use the & or and but use the same one every time. Consistency of data entry is 
EXTREMELY important. 

7- Type the family salutation (e.g. - Bill & Mary).  

NOTE 2.3: The Mailing name or the Salutation will be combined with the Last Name 
for mailing labels, so the two choices will typically be Mr. & Mrs. William Smith or Bill 
& Mary Smith.

8- Make sure the Primary tab is selected. Press the Tab key to move the cursor to the Address Line 1 field.

9- Type the street address of the family.

10- Tab through the Address Line 2, City, State, Zip, Country, Carrier Sort and Primary Phone fields, enter-
ing information into each field as described in items 11 through 17.

11- Type the second line of the street address, if applicable. Leave this field blank if there is no second 
address line.
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NOTE 2.4: It is important to use only Address Line 1 if you want your mailing list to be 
C.A.S.S. certified later for the sake of postal discounts. In the case of a street address 
and a Post Office box, put the Post Office box in Address Line 2.

12- Type the name of the city.

NOTE 2.5: If you followed the instructions in NOTE 2.1 above, the City, State, and/or 
Zip will have been inserted for you. If they are correct, tab past them and go to 
step 15, or you may replace them with other information if this family does not live 
in the default city, state, and zip. 

13- Type the two-letter abbreviation for the State or Province.

14- Type the zip code. The zip + 4 may be typed in if that information is available.

15- Type the country, if applicable (use only if country is not your own).

16- Type the carrier sort number if you know it. This is used by those who qualify for carrier route presort 
mailings. Contact your Post Office for information. The carrier sort prefix is defined under Preferences/
Settings along with the default address. (See Note 2.1 above.)

17- Type the primary phone number, including the area code if you wish. Under Setup on the File menu, 
choose Preferences/Settings, then click on Date/Phone Disp. This is where you auto-format phone 
numbers in CDM Plus [e.g.—choose (###) ###-#### or ###/###-#### or ###-###-####, the 
# sign indicating where numbers will be stored]. Auto-formatting—also called creating a Phone 
Mask—allows you to type only the digits to display a consistent phone number format. CDM Plus will 
automatically add parentheses and dashes or slash marks as indicated by the phone mask. If you 
choose not to create a phone mask, remember to use the same format every time. Consistency of 
data entry is EXTREMELY important.

 Unlisted: Check this box if the phone number is unlisted. How unlisted numbers are printed is handled 
through the Membership Preferences/Settings (reached by choosing Setup on the File menu, then 
choosing Preferences/Settings, then clicking on Membership).

18- Click the Arrow button  beside the Mailing Code field to bring up a list of available mailing codes. 
You may double-click the code you wish to assign or click once on the code and press Return/Enter 
or click Done.

 If you have not established Mailing Codes yet through the Master Coding System (See Appendix A), take 
no action here. CDM Plus will assign a mailing code of 1. When creating Mailing Codes, see Master 
Coding System Tip 1 in Appendix A. You may also create a new Mailing Code from the Mailing Codes 
window using the Create Code button. 

NOTE 2.6: Mailing codes can be created later and families can be assigned different 
codes very easily through the Family Maintenance feature of CDM Plus Membership. 
(See Using Family/Individual Maintenance at the end of this chapter.) 

19- Press the Tab key to move the cursor to the Receives Tape field. Leave blank or type Y or N for YES 
or NO. Mailing labels can be generated for all records with YES in this field. This is helpful for sending 
tapes to shut-ins.

20- Tab to the Receives Video field. As with the Receives Tape field, type Y or N (for YES or NO) or leave 
blank. Mailing labels can also be genreated for all records with YES in this field. 

21- Click the outside Arrow button  beside the Geographical Codes field. The Geographical Codes 
window appears. Double-click all Geographical Codes applicable to this family and then click Done. 
If you have not established Geographical Codes yet through the Master Coding System (See Appen-
dix A), leave this field blank. Codes can be added later if necessary. Geographical codes are used 
to group families by geographical areas, prayer chains, shepherding groups, or other groupings of 
families needed beyond the mailing code breakdown. You may also create a new Geographical 
Code from the Geographical Codes window using the Create Code button.
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NOTE 2.7: Missing reports generated from attendance can be sorted by Geographical 
Code for shepherding groups. To take advantage of this feature the shepherding 
group code should be 8 characters in length and placed at the beginning of the 
geographical code field. See Master Coding System Tip 2 in Appendix A. 

22- A handy field for entering miscellaneous Notes can be 
accessed through the Geographical Codes field. Click 
the first Arrow button  beside the Geographical Codes 
field. A drop-down menu appears. Select Notes from the 
drop-down menu, place the cursor in the Notes field and 
type any text desired.

23- Review the information in the Family Address Record to make sure it is correct. Then press Return/Enter 
or click Save.

24- A dialog box appears asking, Insert Giving Unit Record for this address? If you plan to use the contribu-
tions module of CDM Plus now or at any time in the future, click YES. CDM Plus will then create a Giving 
Unit Record for this family that can be used later to enter contributions. If you do not ever plan to use 
Contributions, or if you want to add Giving Units later, click NO. If someone else handles the Contribu-
tions module, then you may want to check with him/her on how to handle creating new Giving Units. To 
create Giving Units after an address has been entered, click on the Giver's button on the left.

25- If you answer YES to the question about creating a Giving Unit Record, information about the Giving 
Unit Record will be displayed. The address code (See Address Code description below) will be used as 
the Giver’s Code, but it can be replaced with an envelope number if your church uses envelopes. If 
envelope numbers are used, type the number at this time and select the Giver’s Name you prefer to 
use. Be sure to use leading 0‘s for one and two-digit numbers (e.g., 001, 002, 010, 011, etc.).

26- Press Return/Enter or click OK.

The Family Address Record entry for this family is now complete. 

Special Fields in the Family Address Record. 
Access #: Number assigned by CDM Plus to each family in the order they are entered. Used 
in creation of the address code. Numbers will not be reused even if records are deleted.

Address Code: Made up of first four letters of last name plus the access number. Used to 
connect other records in the system to the address.

Entered: Date automatically updated by CDM Plus when a record is inserted. 

Amended: Date automatically updated by CDM Plus when a record is changed. 

Certified: Indicates whether or not address is C.A.S.S. certified for additional postal discount. 

Other Phone: Select Family or Individual from drop down to display additional phone 
numbers. Additional family phone numbers may be added here. Additional individual 
phone numbers must be added by clicking the Other Individual Phones button in Individual 
Records.

Special Buttons on Family Address Record
LN Find - Finds all the Family Address Records with the same last name. You have three search 
options: Exact, for when the spelling is certain, and Begins With and Contains to help when 
the exact spelling is unknown. Once the list is displayed, double-click on the Family Address 
Record desired and it will be displayed. 
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Print - Provides opportunity to print Master List of all family information or print address informa-
tion to a label, envelope, or to the clipboard.

Photo - Brings up a window where a picture of the family can be inserted.

Giver’s - Displays list of giver’s codes assigned to this household. Additional giver's codes may 
be created from this screen using the Add button. 

Visits - Displays a list of all visits made to this household as recorded in Visitation Records.

Swap - Use this button to replace the primary address information with the alternate address 
and vice a versa.

Dial - Dials phone number if proper modem installation is provided.

Indv - Goes to the Individual Record for the currently-selected individual. 

Add (beside "Individuals" field) - To add another individual to this particular address. 

Reorder - Allows for the reordering and reassigning of family status codes to individuals.

Alternate tab: Alternate address (e.g.—Florida 
address during the winter) can be recorded 
here.

Adding Individual Records

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.. 

2- Under Membership select Family 
Address Records or click the 

Family Address Records icon  
on the menu bar. 

3- Locate the family using either the 
Find or LN Find options.

4- If no individuals have been entered 
for this address, no individual 
names will appear in the Individu-
als field in the lower right of the 
window. To add names, click the 
long Add button below the Indv 
button.

Note 2.8: It is recommended that individual family members be added in the following 
order: Head of Household, Spouse (if applicable), Children (if applicable) from oldest 
to youngest. This helps in the establishment of the Individual Record # (described 
later) and in future searches.
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5- The Name window of Individual 
Records will appear. Address 
Code, Phone, and Address Info 
will be visible and the Address 
Code will be highlighted.

6- Press the Tab key to move the 
cursor to the Last Name field.

7- The family last name will appear 
automatically in the Last Name 
field and will be highlighted. 
If the individual being added 
has a different last name, that 
name may be typed in now. If 
the individual’s last name is the 
same as the family last name, Tab to the Suffix field. 

8- Type a suffix, if applicable (e.g., Jr., Sr., III). Leave this field blank if there is no suffix. 

9- Tab through the First Name, Middle/Maiden, Preferred and Title fields, entering information as instructed 
in steps 10 through 13.

10- Type the first name (e.g. - William) in the First Name field.

11- Type a middle or maiden name in that field, if the information is available.

12- Type the preferred name if it is different from the first name (e.g. - Bill for first name William). If a 
preferred name is to be used on reports, labels, cards, and letters, use the mouse to put an X in the 
check box beside Use Pref. Name under Report Preferences. 

13- Type the individual’s title (e.g. - Mr., Mrs., Ms., Miss, Rev., Dr., Pastor, Bishop, etc.).

14- Click the Arrow button  beside the Family Status field. The choices are H for Head of Household, 
S for spouse, C for child, O for other family member such as cousin, mother-in-law, etc. Double-click 
on one of the choices, placing that code in the Family Status field, or click the code once and press 
Return/Enter or click Done. Additional codes may be created through the Master Coding System 
(See Appendix A). You may also create a new code from the Family Status Codes window using the 
Create Code button.

NOTE 2.9: The Other Individual Phones/Email button allows for the input of other 
phone numbers (cellular, pager, etc.) or other information such as an e-mail address 
for each individual.

15- Press the Tab key to bring up 
the Personal window and move 
the cursor to the Sex field. Type 
F for female or M for male in this 
field. 

16- Click the Arrow button  beside 
the Marital Status field. The 
choices are M for married, S for 
single, D for divorced, W for wid-
owed. Double-click on one of 
the choices, placing that code 
in the Marital Status field, or 
click the code once and press 
the Return/Enter or click Done. 
Additional codes may be created 
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through the Master Coding System (See Appendix A). You may also create a new code from the Marital 
Status Codes window using the Create Code button.

17- Tab through the remaining fields on the Personal Information window, typing in any information avail-
able at the time. When a field has a Calendar button , click on the button to bring up a calendar. 
Navigate to the correct year and month on the calendar, and double click on the desired date. 
The calendar will disappear and the correctly-formatted date will appear in the field. Alternately, 
you may enter dates manually.

NOTE 2.10: Many of the fields in the Individual records can be left blank initially and 
then filled in later after a membership questionnaire or survey has been distributed 
and returned. This information can be input at any time in the future as it becomes 
available. Using the Field Maintenance function will allow for quick data entry. 

18- After completing this window, 
with the cursor in the Donor field, 
press the Tab key to bring up the 
Membership window and move 
the cursor to the Asterisk field. 

19- Type Y or N in the asterisk field. 
How you use the asterisk func-
tion is up to you, but one of its 
most common uses is to distin-
guish between members and 
non-members in the church 
directory. Yearbook directories 
will place an asterisk beside the 
name of everyone who has a 
YES in this field. The asterisks 
may also be left out.

20- Click the Arrow button  beside the Membership Code field and double-click your choice. If you 
have not created any Membership codes yet, you may do so through the Master Coding System (See 
Appendix A). You may also create a new code from the Membership Codes window using the Create 
Code button. When creating Membership Codes, see Master Coding System Tip 3 in Appendix A. 

NOTE 2.11: Membership Codes can be created later and individuals can be assigned 
different codes very easily through the Individual List Maintenance feature of CDM 
Plus Membership. (See Adding individual membership and status codes through 
Individual List Maintenance at the end of this chapter.)

21- Click the Arrow button  beside the Membership Status field and double-click your choice. If you 
have not created any Membership Status codes yet, you may do so through the Master Coding 
System (See Appendix A). You may also create a new code from the Status Codes window using 
the Create Code button. When creating Membership Status codes see Master Coding System Tip 3 
in Appendix A. 

NOTE 2.12: Membership Status Codes can be created later and individuals can be 
assigned different codes very easily through the Individual List Maintenance feature 
of CDM Plus Membership. (See Adding individual membership and status codes 
through Individual List Maintenance at the end of this chapter.)

22- Tab through the remaining fields on the Membership Information window, typing in any information 
available at the time. After completing this window, with the cursor in the Dedication Place field, 
press the Tab key, which will bring up the Work/Sch. window and move the cursor to the Occupation 
field. 

23- Type the individual's occupation. 
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24- Click the Arrow button  
bes ide the Occupat ion 
Code field and double-click 
your choice. If you have not 
created any Occupation 
codes yet, you may do so 
through the Master Coding 
System (See Appendix A). You 
may also create a new code 
from the Occupation Codes 
window using the Create 
Code button.

25- Tab through the remaining 
fields on the Work/School 
window, typing in any informa-
tion available at the time. At 
the School field, click the Arrow button  beside the School field and double-click your choice. If 
you have not created any School codes yet, you may do so through the Master Coding System (See 
Appendix A). You may also create a new code from the School Codes window using the Create 
Code button. 

NOTE 2.13: The Other Individual Phones/Email button allows for the input of other 
phone numbers (cellular, pager, etc.) or other information such as an e-mail address 
for each individual. This button is also on the Name tab.

26- Press the Tab key which will bring up the Group window and move the cursor to the Church School 
Status field. This window is for recording participation in church school classes, offices, committees, and 
groups.

27- Click the Arrow button  
beside the Church School 
Status field and double-click 
your choice. If you have not 
created any Church School 
Status codes yet, you may do 
so through the Master Coding 
System (See Appendix A). 
You may also create a new 
code from the Church School 
Status Codes window using 
the Create Code button. 

28- Click the Arrow button  
beside the Church School 
Class field and double-click 
your choice. If you have not 
created any Church School Class codes yet, you may do so through the Master Coding System (See 
Appendix A). You may also create a new code from the Church School Codes window using the 
Create Code button. 

NOTE 2.14: Church School Status is for indicating if one is active or inactive in Church 
School, and Church School Class indicates what class one is in. Class codes are 
established by the user through the Master Coding System (See Appendix A). 

29- To fill in the rest of the fields on the Group Information window, use the Arrow buttons  to enter codes 
created through the Master Coding System (see Appendix A). You may also create new codes from 
the pop-up windows using the Create Code button.
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NOTE 2.15: Church School, Office, Committee, and Group codes can be created 
later, and individuals can be assigned different codes very easily through the 
Individual List Maintenance feature of CDM Plus Membership. (See Adding individuals 
to groups, offices, and committees, etc. through Individual List Maintenance at the 
end of this chapter.)

30- Click on the Misc. tab.

31- To fill in the information in the 
Misc. window, click on the 
Arrow buttons  to enter 
codes created through the 
Master Coding System (see 
Appendix A). You may also 
create new codes from the 
pop-up windows using the 
Create Code button.

NOTE 2.16: In this window, there are 6 user-defined fields which the user can name 
as needed, and codes for them can be created through the Master Coding System 
(see Appendix A). Other field titles can also be renamed to customize the program 
for your particular church (see Renaming Field Titles in Getting Started). 

NOTE 2.17: An Arrow button  beside a field indicates there is a pop-up list of codes 
available for this field. These codes are defined by the user in the Master Coding 
System (See Appendix A). In addition, an asterisk at the end of a field title means 
the field will scroll from right to left and will hold more information than can appear 
in the window.

32- Click on the Comments tab. The Comments field, which has a scroll bar to the right, will hold up to 20 
pages of text. Type any appropriate information in the Comments field.

33- Press the Tab key which brings 
up the Name window and 
highlights the Address Code.

34- Press Return/Enter or click 
Save.

Individual Record input is now com-
plete for this person. 

Now click the Add button and return 
to step 6 of How to insert Individual 
Records and start the process over 
with the next person in the family. 
Do this until all family members are 
in for this particular household. 
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Special Buttons on Individual Record
LF Find - Finds individual by last name and first name for quick retrieval of a specific person.

Print - Provides opportunity to print Master List of all individual information or print address 
information to a label, envelope, or to the clipboard.

Photo - Clicking on this button brings up a window where a picture may be inserted. Click 
on the Import button on the Photo window, then click Paste From File under the Edit menu. 
Navigate to where you have the picture stored. Select it and click open. Windows users need 
to use a picture in BMP, WMF or EMF format. Macintosh users need a PICT. 

Fam Addr - Returns to Family Address Record to which this individual is connected.

Visits - Displays a history of the visits made to this person as recorded in Visitation Records 
under Membership.

Atten. - Displays attendance history for the individual.

Give Unit - Displays the Giving Unit Code assigned to this individual in the Contributions module 
of CDM Plus. If you have not purchased the Contributions module, this button will not be 
available (will be grayed out).

Register - Clicking on this button allows you to register this individual for an event or camp 
through the Event Registration module of CDM Plus. If you have not purchased the Event 
Registration module, this button will not ba available (will be grayed out).

Dial - Dials phone number if proper modem installation is provided.

How to Enter Couples with Different Last Names
Wives sometimes retain their maiden names and do not take the last name of their husband. Following is 
the procedure for entering this into the Family Address Record in CDM Plus so that it appears appropriately 
in the directory and on address labels.

For example, you wish to enter a record for Jim Miller and Joy Ross. 

1-  Type Ross in the Last Name field and Jim Miller and 
Joy in the Mailing Name field. This way, when the 
address label prints for the newsletter, for instance, 
the label will read, Jim Miller and Joy Ross.

This takes care of the mailing label, but what about the 
church directory? If someone wishes to find Jim Miller, 
he would be printed with the R’s under Ross. To remedy 
this situation:

2- Insert another Family Address Record so this family 
can be cross-referenced under Miller. To do this, first create a Mailing Code for this purpose. DCR may 
be used as the code (for Directory Cross Reference).

NOTE 2.18: Include the DCR Code when printing a church directory. Never include 
the DCR code when doing a mailing.
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The additional Family Address Record would look like 
the one at right. Miller appears in the Last Name field 
and DCR in the Mailing Code field.

3- Insert an Individual Record for this Family Address 
Record. Type Miller in the Last Name field and See 
Ross in the First Name field (since the family actually 
appears under Ross in the Family Address Record). 
The new Individual Record will look like the screen 
at right.

When entered in this way, the two Yearbook Directory 
entries print out as follows:

Family entry

Jim Miller & Joy Ross
 1144 Main Street Big City, KY 40123 859/555-8149

 Jim Miller*  Joy Ross*

Cross-reference entry

Miller

 See Ross

In this way, when looking up Miller in the directory, one is referred to Ross, where the family appears with 
complete information.

Of course, if you wish, you may place the husband’s name last on the first Family Address record so it reads 
Joy Ross and Jim Miller. Ross would then be cross-referenced and referred back to Miller.
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Pastoral Records 
NOTE 2.19: Privacy of Pastoral Records in CDM Plus is password protected. Access 
is set in the Membership area of Password Maintenance, which is located under 
Change User Password/Preferences on the File menu. Passwords and preferences 
should be set up when CDM Plus is first installed. For complete instructions, refer to 
the Change User Password/Preferences in Getting Started.

Adding comments in CDM Plus Pastoral Records

1- Under CDM+ on the menu bar, 
select Membership or click the 
Membership Icon on the Tool 
Bar. 

2- Under Membership on the menu 
bar, select Pastoral Records or 
click the Pastoral Records Icon 
on the Tool Bar.

3- Click the Add button.

4- Click the Arrow button  next to 
the Family Address Code field, 
and select the appropriate code 
from the pop-up list. Family infor-
mation, including family name, 
address and phone number, 
appears automatically.

5- Click the Arrow button  next to the Individual Code field, and select the code for the correct indi-
vidual from the pop-up list. The individual's name and birth date is automatically entered.

6- Tab to place the cursor in the Date field. Enter the date.

7- Tab to place the cursor in the Comments field. Enter comments in free text.

8- Click the Save button. Options are now available to Print the comments, return to the linked Family 
Address Record or Individual Record, or Dial the phone (if proper modem installation is provided).

NOTE 2.20: The link from a Pastoral Record to its associated Family Address Record or 
Individual Record only works in one direction. For privacy reasons, there is no link to 
a Pastoral Record from either the Family Address Record window or the Individual 
Record window.

Special Buttons on Pastoral Record
Print - Provides opportunity to print Pastoral Record information or print address information 
to a label, envelope, or to the clipboard. 

Addrs. - Returns to Family Address Record to which this individual is connected.

Indv - Returns to Individual Record for this individual.

Dial - Dials the phone (if proper modem installation is provided). 
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 Visitation Records 
NOTE 2.21: Visitation Records under Membership in CDM Plus allows the user to track 
visits made to people in the church and also reminds of follow-up visits and contacts 
that should be made. Before using Visitation, Staff Codes and Visit Types should be 
created in the Master Coding System (See Appendix A). Also see Master Coding 
System Tip 6 in Appendix A for recommended Staff and Visit Type codes. 

Adding visitation records and follow-up reminders in CDM Plus visitation.
1- Under CDM+ on the menu bar, select Membership or click the Membership icon on the Tool Bar. 

2- Under Membership on the menu bar, select Visitation or click the Visitation icon on the Tool Bar.

3- Click the Add button.

4- Click on the Arrow button  
beside the Family Address Code 
field and choose the code of the 
family visited from the pop-up 
list. 

5- If only one person was visited 
(e.g.—hospital visit), click on the 
Arrow button  beside the Indi-
vidual Code field and make your 
selection from the pop-up list. If 
more than one member of this 
family was visited, leave this field 
blank. 

6- Click on the Arrow button  beside the Staff Code field and make your selection from the pop-up 
list. This may be ministers, staff members or laypersons who make calls (See Master Coding System 
Tip 6 in Appendix A for recommended Staff codes).

7- Press the Tab key to place the cursor in the Date field, and enter the date the visit was made.

8- Click on the Arrow button  beside the Type field and make your selection from the pop-up list (See 
Master Coding System Tip 6 in Appendix A for recommended Type codes).

9- Press the Tab key to place the cursor in the Number field, and type the number of persons visited 
during this call.

10- Press the Tab key to place the cursor in the Miles field, and type the number of miles traveled in 
making this call (optional).

11- Press the Tab key to place the cursor in the Comments field, and type any comments about this visit 
you wish to record (i.e.— Mr. McAllister's funeral was on October 14, 2001. He passed away on the 
11th. Osa is doing fairly well and is surrounded by family). 

12- Press the Tab key to place the cursor in the Date of Follow-up Call Reminder field, and enter the date 
on which you wish to make a follow-up call, contact, or visit.

NOTE 2.22: Go under File on the menu bar to Setup and then to Preferences/Settings. 
Click on Membership and set the number of Tickler File Reminder Days. This tells 
CDM Plus how many days before the Date of Follow-up Call Reminder you wish to 
be notified that a follow-up is pending. 
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13- Press Tab to place the cursor in the Reminder Memo field, and enter information about what type of 
follow-up is needed (e.g.—call, letter, visit, etc.)

14- Press Return/Enter or click the Save button. The record is saved and you will be reminded to make 
the follow-up call based on the number of Tickler File Reminder Days entered under Preferences/Set-
tings. 

NOTE 2.23: When the date falls within the range prescribed by the Tickler File 
Reminder Days, the following message will appear as CDM Plus is launched:

Click Yes to print the tickler records and distribute them to the appropriate people who need to make 
the follow-up call(s). Click No if you do not wish to print them now. The system will continue to remind you 
each time CDM Plus is launched. 

If you print the records, you will be asked if you want the records marked as printed. Say Yes if you do not 
wish to be reminded again; click No if you do wish to be reminded again. 

Special Buttons on the Visitation Records screen.

 Reports - Provides multiple format options for reporting visitation acitvity.

 Addrs. - Returns user to Address Record screen for family displayed on visitation record.

 Indv. - Returns user to Individual Record screen for individual displayed on visiation record.

 Visits - Pops up a list of all currently recorded visits to this family.

 Dial - Dials phone number of displayed record with proper modem hookup. 

The Visitation Records feature of CDM Plus allows the church to keep up with the visitation needs of the con-
gregation and prevents the staff from overlooking the pastoral care needs of members of the church.

It is especially helpful to record the anniversary dates of deaths in the church. In that case, the computer 
begins to remind the user of the follow-up call which needs to be made to Mrs. Smith on the anniversary 
of her husband’s death. It will begin reminding you 5 days before the anniversary, or as many days ahead 
as you indicate in the Tickler file Reminder Days under Preferences/Settings. 

Appendix E includes a sample CDM Plus Visitation Records Report Form. The person making calls may use 
this to record their visits. Then the information can be input into the computer by someone else, if neces-
sary. You may photo-copy this form or use it as a guideline to set up your own, considering that your visit 
types may be different. 
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Membership Reports
Following are instructions for printing some of the most commonly used reports generated out of CDM Plus 
Membership.

Mailing Labels

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Reports, select Address Labels and then Mailing Labels-Family.

3- Select Mailing codes to be printed. Type or double-click up to 12 mailing codes to be included in this 
mailing, placing them in the 12 selection boxes. Or leave the selection boxes blank to print all codes.

6- Press Return/Enter or click OK.

7- Select the type of label from the 
Avery list or click on the Envelope 
Tab to print directly onto envelopes. 
You can adjust any settings for a 
line item or change the name of a 
line by clicking on the Adjust Set-
tings button in the upper left-hand 
corner. Use the Options check-
boxes to choose which additional 
information to include on the 
label or envelope, such as phone 
#, access #, whether to use the 
Salutation instead of the Mailing 
Name, and whether to print the labels in all caps. You may also choose to do an alignment test at 
this point. 

NOTE 2.24: Make sure the proper type of 
labels are in the printer before running an 
alignment test or printing the labels.

8- If you are printing laser labels and want to begin 
printing on a specific line of the sheet of labels, 
then enter that line in the Start on Row field. Note 
that this only affects the first page of labels to be 
printed.

9- Choose the proper Sort order by selecting from the 
pull-down menu on the lower right-hand corner of 
the window. The USPS option will print the labels 
in the proper order for bulk mailings as required 
by the post office. It will also generate the proper 
documentation for preparation of your postage 
statement.

10- Select Printer on the Set Report Destination 
screen.

11- Press Return/Enter or click OK and labels or envelopes will be printed.

Church Directories
The most commonly-used format for a church directory is the Yearbook Directory. To print a yearbook 
directory, do the following:
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1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Reports, select Yearbook Directory.

3- Select Mailing codes to be printed. Type or double-click 
up to 12 mailing codes to be included in this directory, 
placing them in the 12 selection boxes.

4- Press Return/Enter or click OK.

5- Double-click on the Custom Yearbook Reports format 
to be used (e.g.—Across the Page).

6- Select Printer on the Set Report Destination screen.

7- Press Return/Enter or click OK and a directory will be 
printed.

Group, Committee, Officer, etc. Labels or Envelopes

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under List Repts, select Labels.

3- Double-click your choice from Select List (e.g.—Current 
Church Groups)

4- The Select Codes for Print Out window appears.

5- Double-click the Church Group(s) you want labels for from 
the Currrent Church Groups Codes window on the right, 
moving them to the Print List window on the left.

6- Click OK.

7- Select type of label from the Avery list or click on the Enve-
lope Tab to print directly onto envelopes. You may choose 
to do an alignment test at this point. 

NOTE 2.25: Make sure proper type of labels are 
in the printer before running an alignment test or 
printing the labels.

8- Select Label Addressee And Sort window now appears.

9- Select desired options by turning on radio buttons and/or 
checkboxes with the mouse.

10- Press Return/Enter or click OK.

11- Select Printer on the Set Report Destination screen.

12- Press Return/Enter or click OK and labels will be printed.
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Group, Committee, Officer, etc. Cards

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under List Repts select Card Notice.

3- Double-click your choice from Select List (e.g.—Church School)

4- The Card Notice window appears.

5- Click Add or click on the Arrow button  
beside the Code field to see a pop-up list 
of the choices. From this list, double-click 
your choice. 

7- Press the Tab key, and enter the date to 
appear on the card notice.

8- Press the Tab key, and type the message 
you wish to appear on the card notice. 
Include only the text, not the salutation. 
CDM Plus will create the salutation for you, 
placing the first or preferred name after the 
word “Dear.”

9- Select desired options at the bottom of this screen, including Printer Type.

NOTE 2.26: Once several cards have been entered in CDM Plus, you may use the 
Find button to locate previously-saved cards and just change the date to be printed 
on the card and the date and time of the meeting and use the card again without 
typing in a completely new card.

10- Click Save.

11- Click the Print button.

12- Select Sort Order: Alphabetical Order, Zip Code Order, or Carrier Sort Order.

13- Press Return/Enter or click OK and personalized cards will be printed.

 

Group, Committee, Officer, etc. Letters

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under List Rpts select Letter Notice.

3- Double-click your choice from Select List (e.g.—Currrent Church Groups)

4- The Letter Notice window appears.

5- Click Add or click on the Arrow button  beside 
the Code field to see a pop-up list of available 
Group Codes. From this list, double-click your 
choice. 

6- Press the Tab key, and enter the date to appear 
on the letter notice.

7- Press the Tab key, and type the message you wish 
to appear on the letter notice. Include only the 
text, not the salutation. CDM Plus will create the 
salutation for you, placing the first or preferred 
name after the word “Dear.”
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 Please note that this field is not "WYSIWYG" 
(what you see is what you get). For example, 
changing the font size or margins will not be 
reflected in what you see on this window, 
only in what you print.

8- Select desired options, including Font Size 
and Margins so the letter will fit on your let-
terhead. Also, turn on the checkbox beside 
Print address info. if you want the inside 
address to be printed on the letter. 

9- Select Sort Order: Alphabetical Order, Zip 
Code Order, or Carrier Sort Order.

10- Click Save.

NOTE 2.27: Once several letters have been entered in CDM Plus, you may use the 
Find button to locate previously saved letters and just change the date to be printed 
on the letter and the date and time of the meeting and use the letter again without 
typing in a completely new letter.

11- Click the Print button.

12- Select Printer on the Set Report Destination screen.

13- Press Return/Enter or click OK and personalized letters will be printed.

NOTE 2.28: At this point you may return to the instructions for doing Group, Committee, 
Officer, etc. Labels or Envelopes on page 18 and print envelopes to go with the 
personalized letters just printed. 

Group, Committee, Officer, etc. Directories

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under List Repts, select List Directory.

3- Double-click your choice from Select List e.g.—Current Church Groups)

4- The Select codes for print out window appears.

5- From the Current Church Groups Codes window on the right, double-click the Church Group(s) for 
which you want to print a directory, moving them to the Print List window on the left.

6- Click OK.

7- Select Sort Order: Alphabetical Order, Zip Code Order, or Carrier Sort Order.

8- Press Return/Enter or click OK.

9- The Report Preference Defaults window now appears. Select desired options by turning on radio 
buttons and/or the checkbox with the mouse.

10- Press Return/Enter or click OK.

11- Select Printer on the Set Report Destination screen.

12- Press Return/Enter or click OK and the directory will be printed.
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Using Family/Individual Maintenance
Adding mailing codes to Family Address Records through Family Maintenance

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Membership, select Family Maintenance and under Family Maintenance, select List Mainte-
nance.

3- Turn on radio button beside Mailing Code and press Return/Enter or click OK.

4- The Mailing Code Maintenance window appears and all family names will load in the Families 
window. 

5- Use the drop-down list to select the 
Mailing Code you wish to assign. 
Any families already assigned 
this mailing code appear in the 
Assigned window to the left. 

6- The selected code will be high-
lighted in the field above the 
lists. 

7- Double-click the family names 
you wish to assign this mailing 
code in the Families window on 
the right, moving them to the 
Assigned window on the left. 

8- Click the Save button.

9- The selected Family records will be updated. You may update another list by clicking the Another 
button and returning to step 3 above.

NOTE 2.29: It is wise to do one code after another at one sitting. This way you only 
have to wait for the families to load one time. 

Adding individual membership and status codes through Individual Maintenance

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Membership, select Individual Maintenance and under Individual Maintenance, select List 
Maintenance.

3- Double-click Membership Code.

4- All individual names will then load into the Individuals window. 

5- Use the drop-down list to select the Membership Code you wish to assign. Any individuals already 
assigned this Membership code will appear in the Assigned window to the left. 

6- The selected code will be highlighted in the field above the lists. 

7- Double-click the individual names you wish to assign this membership code to in the Individuals 
window on the right, moving them to the Assigned window on the left. You may also click and drag 
across multiple names selecting them all at once. A click of the mouse on the selection, followed by 
a slight pause, will turn the pointer into a hand which you can use to drag the entire selection to the 
other list.
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8- Click the Save button.

9- The selected individual records will be updated. You may update another list by clicking the Another 
button and returning to step 3 above.

NOTE 2.30: It is wise to do one code after another at one sitting. This way you only 
have to wait for the individuals to load one time. 

Follow this same procedure to assign Membership Status codes to individual records.

Adding individuals to groups, offices, and committees, etc. through Individual 
Maintenance

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Membership, select Individual Maintenance and under Individual Maintenance, select List 
Maintenance.

3- Double-click Current Church Groups.

4- All individual names will then load into the Individuals window. 

5- Use the drop-down list to select the Current Church Group Code you wish to assign. Any individuals 
already assigned this Group code will appear in the Assigned window to the left. 

6- The selected code will be high-
lighted in the field above the lists. 

7- Double-click the individual names 
you wish to assign this Current 
Church Group code in the Individ-
uals window on the right, moving 
them to the Assigned window on 
the left. You may also double-
click names in the Assigned list 
if they are to be removed from 
the group. You may also click 
and drag across multiple names, 
selecting them all at once. A click 
of the mouse on the selection, fol-
lowed by a slight pause, will turn 
the pointer into a hand which you 
can use to drag the entire selection to the other list. 

8- Click the Save button.

9- The selected individual records will be updated. You may update another list by clicking the Another 
button and returning to step 3 above.

NOTE 2.31: It is wise to do one code after another at one sitting. This way you only 
have to wait for the individuals to load one time. 

Follow this same procedure to assign Committees, Offices, and other codes to individual records.
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Adding individuals to Church School Classes through Individual Maintenance

1- Under CDM+, select Membership or click the Membership icon  on the tool bar.

2- Under Membership, select Individual Maintenance and under Individual Maintenance, select List 
Maintenance.

3- Double-click Church School.

4- All individual names will then load into the Individuals window.

5- Use the drop-down list to select the Church School Class Code you wish to assign. Any individuals 
already assigned this Church School Class code will appear in the Assigned window to the left. 

6- The selected code will be highlighted in the field above the lists. 

7- Double-click the individual names you wish to assign this Church School Class code in the Individuals 
window on the right, moving them to the Assigned window on the left. You may also double-click 
names in the Assigned list if they are to be removed from the class. You may also click and drag 
across multiple names, selecting them all at once. A click of the mouse on the selection, followed 
by a slight pause, will turn the pointer into a hand which you can use to drag the entire selection to 
the other list.

8- Click the Save button.

9- The selected individual records will be updated. You may update another list by clicking the Another 
button and returning to step 3 above.

NOTE 2.32: It is wise to do one code after another at one sitting. This way you only 
have to wait for the individuals to load one time. 
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